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Predgovor 

Današnje društvo obilježeno je naglim rastom i razvojem informacijske 

tehnologije (IT), što je rezultiralo velikom ovisnošdu društva, u širem smislu, 

o znanju i kompetencijama osobe u IT području. I premda ta ovisnost raste 

iz dana u dan, ljudsko pravo na obrazovanje i informacije nije prošireno i 

na IT područje. Pojavili su se problemi koji utječu na društvo u cjelini, koji 

stvaraju prepreke i udaljavaju ljude od glavnog razloga i motivacije za 

napredak, od prilike. Danas, biti računalno nepismena osoba, znači biti 

osoba koja nije u mogudnosti sudjelovati u modernom društvu, osoba bez 

prilike, i unatoč priznatoj neophodnosti i korisnosti inkluzivne informatičke 

pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih 

relevantnih institucija, još uvijek postoje grupe ljudi sa otežanim pristupom 

osnovnoj računalnoj naobrazbi (npr. osobe s invaliditetom, osobe s 

poteškodama u učenju, radnice/i migranti, nezaposlene osobe, osobe koje 

žive na udaljenim mjestima gdje nemaju pristup računalnoj edukaciji). 

 

Ove skripte, zajedno sa ostalim materijalom objavljenim na stranici 

ITdesk.info, predstavljaju naš doprinos realizaciji I promociji ljudskog prava 

na edukaciju i informacije u IT području. Nadamo se da de Vam ova 

edukacija pomodi u savladavanju osnovnih računalnih vještina i sa tom 

nadom želimo Vam da naučite što više i tako postanete aktivni/a član/ica 

modernog IT društva. 

 

Iskreno Vaši, 

 

ITdesk.info team 
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Prvi koraci u radu s računalom 

 uključivanje računala 

o spojiti sve komponente 

o pritisnuti tipku za uključenje na računalu 

o eventualno upisati korisničko ime i lozinku 

 isključivanje računala 

o ,  zatim   

o pojavljuje se prozor sa opcijama:  

• Pripravnost / Stand by 

• Isključivanje / Turn Off –  opcija za gašenje računala 

• Ponovo pokretanje sustava / Restart  (tipka Reset na 

kudištu ima istu funkciju) – opcija za gašenje i 

ponovno paljenje računala 

 

 u slučaju da neka aplikacija ne reagira 

na naredbe pozivamo Task Manager: 

o istovremeni pritisak na tipke Ctrl + Alt 

+ Delete na tipkovnici 

o na prvoj kartici, „Applications“ 

odaberemo aplikaciju koju želimo 

ugasiti te odaberemo naredbu „End 

Task“ 

 

 

 

 

 Funkcija pomodi se otvara tako da 

pritisnemo lijevom tipkom miša na Start, zatim Help i otvara se slijededi prozor: 

 

http://hr.wikipedia.org/wiki/Ra%C4%8Dunalo
http://hr.wikipedia.org/wiki/Ra%C4%8Dunalna_sigurnost
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o u polje Pretraži / Search upišemo područje o kojem bismo voljeli znati više i pritisnemo 

lijevu tipku miša na strelicu pokraj polja ili pritisnemo tipku Enter 

 

 

WINDOWS XP 

 

 jedan od operativnih sustava (softvera koji korisnikove naredbe pretvara u računalu razumljiv 

jezik) 

 

Radna površina (Desktop) 

 

 podloga na kojoj se radi i koja se uvijek nalazi u pozadini, predstavlja „uredski stol“,  

 postoje mnogi načini da si korisnici /ce prilagode izgled radne površine 

 na njoj su smještene: 

o Gumb Start 

o Ikone 

o Traka sa zadadama (Taskbar) 

 

 

Start izbornik: 

 služi za početak rada odnosno biranje određene mape ili programa 

 pritisak lijeve tipke miša na gumb > otvara se izbornik s podizbornicima: 

 
 u lijevom stupcu: 

o prečice za korištene Internet preglednike (program kojim se pretražuje Internet i u kojem 

se otvaraju web stranice), na slici: Mozilla Firefox i Internet Explorer, program za slanje i 

primanje elektronske pošte (e-mail), na slici Mozilla Thunderbird   

o prečice za najčešde korištene programe (aplikacije, softver), na slici: FileZilla, Media Player 

Classic, Notepad, itd. 

o Svi programi (All Programs) – biranje i pokretanje željenog programa 

http://hr.wikipedia.org/wiki/Ra%C4%8Dunalo#Operacijski_sustav
http://hr.wikipedia.org/wiki/Softver
file:///C:/Documents%20and%20Settings/User/Desktop/Internet
http://hr.wikipedia.org/wiki/Web_stranice
http://www.mozilla.com/en-US/
http://www.microsoft.com/nz/windows/internet-explorer/default.aspx
http://www.mozillamessaging.com/en-US/thunderbird/
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 u desnom stupcu: 

o Moji dokumenti (My Documents) – izravno otvaranje mape u kojoj su nam najčešde 

spremljene datoteke 

o Moji nedavni dokumenti (My Recent Documents) – popis nedavno korištenih datoteka  

o Moje slike (My Pictures) - izravno otvaranje mape gdje su nam najčešde spremljene slike 

o Moje računalo (My 

Computer) – otvaranje 

pregleda i pristupa do 

mapa i diskova 

 

 

 

 

 

 

 

 

 

 

 

o Pisači i faksovi (Printers and Faxes) – pregled i podešavanje pisača i faksova 

o Upravljačka ploča (Control panel) – podešavanje računala 

o Pomod i podrška (Help and Support) – pomod o Windows XP 

o Traži (Search) – pronalaženje datoteka ili mapa na čvrstom disku, CD-u ili Internetu 

o Pokreni (Run) – pokretanje programa upisivanjem izvršne datoteke 

o Odjavi korisnika (Log off) – odjavljivanje korisnika, ali ne i gašenje računala 

o Isključi računalo (Turn Off Computer) – gašenje ili ponovno pokretanje računala 

 

Ikone: 

 sličice koje predstavljaju programe, programske prečice, mape ili datoteke 

 predefinirane ikone MS Widows-a: My Computer, My Documents, Recycle Bin 

 najčešde: mape, programi za obradu teksta (OpenOffice.org Writer, Microsoft Word) 

 
Rad s ikonama 

 Označavanje ikone: pokazivačem miša (kursorom) se pozicioniramo iznad željene ikone, 

pritisnemo te otpustimo lijevu tipku miša; ikona se zatim ispuni bojom, znak da je označena 

 Pomicanje ikone (uhvati-povuci-pusti metoda; drag-and-drop): 

1. pritisnemo i zadržimo lijevu tipku miša na željenoj ikoni 

2. odvučemo ikonu na željenu poziciju 

3. otpustimo lijevu tipku miša 
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 Otvaranje ikone: 

o dvaput brzo pritisnemo lijevu tipku miša na ikonu, ili 

o označimo ikonu i pritisnemo tipku Enter 

 

Prečice  

 dvostrukim pritiskom na lijevu tipku miša pokredemo ono na što prečica pokazuje  

 ikona radi raspoznavanja ima strelicu u donjem lijevom kutu 

 zauzima 1 kb, briše se bez posljedica na program ili dokument na koji pokazuje 

 kreiranje: 

1. pritisnemo i zadržimo desnu tipku na željenom programu, mapi, datoteci 

2. odvučemo je na radnu površinu i otpustimo desnu tipku miša 

3. odaberemo Kreiraj prečicu ovdje / Create Shortcut Here 

 

Traka sa zadadama (Taskbar): 

 
 nalazi se na dnu radne površine 

 prikazuje pokrenute programe, otvorene mape i datoteke, tj. ono na čemu i RAM trenutno 

„radi“ 

 može se premještati, sakriti / hide, dodavati različite programe koji se nakon toga mogu 

pokrenuti i na ovaj način 

 

Prozori 

 svi programi i mape se otvaraju unutar pravokutnika kojeg nazivamo prozor 

 elementi: 

 

 

 

 

 

 

 

 

 

 

 

 

1. Naslovna 

traka 

2. Traka 

Izbornika 

3. Traka 

alata 

4. Statusna traka 

5. Traka klizača – horizontalna i vodoravna 

6. Gumbi minimiziraj, maksimiziraj (odnosno vrati, ako je prozor maksimiziran) i zatvori 
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 Premještanje prozora: 

o pritisnemo i zadržimo lijevu tipku miša na naslovnoj traci i pomičemo prozor u željenom 

smjeru (metoda uhvati-povuci-pusti; drag and drop) 

 Promjena veličine prozora:  

o pokazivač miša pozicioniramo iznad ruba prozora, pritisnemo i zadržimo lijevu tipku miša 

te ga smanjimo ili povedamo 

 Gumbi u gornjem desnom kutu prozora (manipulacijski gumbi): 

 minimiziraj: prozor spuštamo na traku sa zadadama 

 maksimiziraj: raširimo prozor preko cijele radne površine 

   vrati (Restore Down): vradamo prozor na veličinu prije maksimizacije 

 zatvori (Close):  zatvaramo prozor 

 

Rad s više prozora 

 možemo imati više otvorenih prozora, a samo je jedan aktivan 

 aktivni prozor ima istaknuti okvir, dok neaktivni ima zasivljen 

 otvoreni prozor postaje aktivan ukoliko pritisnemo lijevu tipku miša na njega 

 otvoreni prozori postaje aktivan i ako pritisnemo lijevu tipku miša na njegov odsječak na Traci 

sa zadadama / Taskbar 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ORGANIZACIJA PODATAKA NA RAČUNALU 

 

Uređaji za pohranu podataka 

 Čvrsti disk (Hard Disk) 

 Disketa (Floppy Disk) 

 CD, DVD 

http://hr.wikipedia.org/wiki/Hard_Disk
http://hr.wikipedia.org/wiki/Disketa
http://hr.wikipedia.org/wiki/DVD
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 USB štapid / USB Stick 

 mrežni (online) uređaji za pohranu podataka (pogodnost pristupa, mogudnost dijeljenja 

datoteka) 

 

Rad s uređajima za pohranu podataka unutar Windows XP-a 

 otvaranje prozora za prikazivanje uređaja za pohranu podataka: Start > My Computer 

 
 svaki uređaj posjeduje ikonu, naziv i slovo u zagradi (A, B, C, D, E...) 

 čvrsti disk (Hard Disk Drive) može biti jedan, može ih biti više ili jedan može biti podijeljen na 

više dijelova (particije) 

 

A  disketni pogon / Floppy    

    

kada čvrsti disk nije 

podijeljen i priključen je 

DVD-ROM 

kada čvrsti disk nije podijeljen i 

priključeni su DVD-ROM i CD-

RW 

kada čvrsti disk je podijeljen na 

dva dijela (particije) i priključeni su 

DVD-ROM i CD-RW 

C Čvrsti disk C Čvrsti disk C Čvrsti disk (prva particija) 

D DVD-ROM D DVD-ROM D Čvrsti disk (druga particija) 

  E CD-RW E DVD-ROM 

    F CD-RW 

 

Datoteke i mape 

 podaci na računalu su organizirani u datoteke (Files) 

o datoteka: skup digitalnih podataka koji predstavljaju konkretan sadržaj (tekst, slika, 

videozapis, program) 

• određena je imenom i ekstenzijom 

• ekstenzija označava format datoteke (označava što datoteka sadrži slika - .jpg, 

word - .doc, MP3 - .mp3) 

 datoteke se smještaju u mape (folders) 

o mapa (ili direktorij): okvir u koji se smještaju datoteke ili druge mape radi bolje organizacije 

i preglednosti 

http://hr.wikipedia.org/wiki/USB
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o glavna mapa može sadržavati podmape, koje mogu imati svoje podmape, u kojima se 

mogu nalaziti podmape... - grananje mapa  

o Path – put do željene mape odnosno datoteke 

o ukoliko u prozoru mapa odaberemo alat Mape (Folders) prikazuje se Windows Explorer 

pogled  

o na lijevoj strani pojavljuje se hijerarhijska struktura 

 
Rad s datotekama i mapama u Windows Exploreru 

 hijerarhijski prikazuje mape i datoteke unutar uređaja za pohranu podataka 

 Start > All porgrams > Accessories > Windows Explorer ili desna tipka mišem na Start > 

Explore 

 rad u lijevom prozoru: 

o prikazuje cjelokupnu strukturu mapa, olakšava navigaciju 

o +  mape se dodatno granaju 

o –  mape su razgranate 

o pritisnemo lijevu tipku miša na mapu i u desnom prozoru se pokazuje sadržaj 

 rad u desnom prozoru: 

o mape otvaramo dvoklikom lijeve tipke 

• Naziv (Name) – popisane su datoteke i mape po nazivima 

• Veličina (Size) – veličina mapa i datoteka 

• Vrsta (Type) – tip datoteke 

• Promjene (Date Modified) – datum zadnje promjene na datoteci 

• Statusna traka – ma dnu prozora; informacije o mapi ili datoteci 

 

Stvaranje mapa i podmapa 

 preko Windows Explorer: u lijevom prozoru označimo mapu u kojoj želimo stvoriti novu 

mapu i: 

o na traci s izbornicima odaberemo File, zatim New > Folder > Upišemo ime > Enter ili 

o pritisnemo desnu tipku miša u desnom prozoru > New > Folder > Upišemo ime > Enter 
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Prikaz imena, veličine i lokacije mape i podmape 

 prikaz se može mijenjati na alatnoj traci preko alata View / Prikaz a opcije su: 

o Minijature (Thumbnails) 

o Pločice (Tiles) (na slici ispod) 

o Ikone (Icons) 

o Popis (List) 

o Detalji (Details) 

 

 
 

 Svaka datoteka i mapa ima Svojstva / Properties 

o desna tipka mišem na datoteku otvara brzi izbornik  te 

odaberemo Svojstva  

o prikazuje se lokacija, veličina, datum kreiranja, 

promjene, autor itd. 

 

 

 

 

 

 

 

 

 

 

Datoteke i mape možemo skrivati: 

 desna tipka miša na datoteku ili mapu > Properties > na kartici General > Hidden > Apply > OK 

 *ako želimo sakriti mapu pojavljuje se dijaloški okvir Potvrdi promjene svojstva / Confirm 

Attribute Changes sa opcijama:  

o Primjeni promjene samo na ovu mapu / Apply changes to this folder only 

o Primjeni promjene na ovu mapu, podmape i datoteke / Apply changes to this folder, 

subfolders and files 
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 Skrivene mape i datoteke možemo učiniti vidljivima: 

o Tools > Folder Options > View > uključiti Show hidden files and folders; Apply  > OK 

 

Promjena statusa datoteke 

 datoteke možemo otvoriti, modificirati i pobrisati, osim ako nije drukčije zadano u njenim 

Svojstvima /Properties 

o ako želimo datoteci promijeniti status tako da bude dostupna samo za čitanje (Read Only): 

na kartici Svojstva / Properties pritisnemo lijevu tipku miša u potvrdi okvir (kvadratid) 

pokraj Read Only atributa čime se u njemu pojavljuje kvačica. Potvrdimo promjenu 

gumbom Primjeni / Apply i na kraju gumbom OK. 

o kad želimo opet promijeniti status datoteci, ponovno pritisnemo lijevu tipku miša u isti 

potvrdi okvir dok on ne postane opet prazan; potvrdimo promjenu gumbom Primjeni / 

Apply i na kraju gumbom OK. 

 

Prikaz ekstenzija datoteka 

 datoteke imaju ekstenzije – nastavak na ime 

odvojen točkom, koje određuju tip datoteke, tj. koji 

de program otvoriti datoteku ako dvostruko 

kliknemo na nju 

o prikaz ekstenzije: otvorimo izbornik Alati / Tools, i 

odaberemo Folder Options; otvorimo karticu 

Pogledi / View i kliknemo na potvrdni okvir (time 

uklonimo kvačicu) pokraj opcije Hide extensions 

for known file types. Potvdimo promjenu 

gumbom Primjeni / Apply i na kraju gumbom OK. 

o sakrivanje ekstenzije: postavimo kvačicu u 

potvrdni okvir (ponovno klikanjem na njega) 

pokraj opcije Hide extensions for known file types  
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Najčešde korištene datoteke: 

 

OpenOffice.org paket uredskih programa Ekstenzija: 

tekstualni dokument: Writer .odt 

izrada i pregled prezentacija: Impress  .odp 

rad s tabličnim kalkulatorom: Calc .ods 

 

Microsoft Office 
Ekstenzija: 

verzija 2003 verzija 2010 

tekstualni dokument: Word dokument .doc .docx 

izrada i pregled prezentacija: PowerPoint prezentacija .ppt .pptx 

rad s tabličnim kalkulatorom: Excel dokument .xls .xlsx 

 

Ostali programi: Ekstenzija: 

glazbeni zapis .mp3 

slika .jpg 

video zapis .mpeg 

komprimiran (sažet) sadržaj .zip 

izvršna datoteka (program) .exe 

 

Preimenovanje datoteka i mapa 

 desna tipka mišem na datoteku ili mapu > Preimenuj / Rename > Upišemo novo ime i 

pritisnemo Enter 

 potrebno je paziti da ne promijenimo i ekstenziju jer inače možda više ne možemo otvoriti 

datoteku 

 

Označavanje mapa i datoteka (selektiranje) 

 jednu – pritisnemo lijevom tipkom miša na datoteku 

 više u nizu – pritisnemo lijevom tipkom miša na prvu > pritisnemo i zadržimo tipku Shift + 

pritisnemo lijevom tipkom miša na posljednju, otpustimo tipku Shift 

 više koje nisu u nizu – pritisnemo lijevom tipkom miša na prvu, pritisnemo i zadržimo tipku 

Ctrl + pritisnemo lijevom tipkom miša na ostale datoteke ili mape 

 označavanje svih datoteka unutar određene mape: Edit > Select All ili Ctrl + A 

 

Prebrojavanje datoteka 

 prebrojavanje unutar mape: desna tipka mišem na mapu > Svojstva / Properties > vidimo 

koliko mapa sadrži datoteka i podmapa 

 prebrojavanje datoteka istog tipa:  Prikaz / View > Detalji / Details > prikaz Type > Označimo 

datoteke iste vrste > u statusnoj traci piše njihov broj 

 

Umnožavanje datoteka ili mapa (kopiranje): 

1. označimo datoteku ili mapu koju želimo kopirati 

2. pritisnemo desnu tipku miša i na izborniku odaberemo alat Kopiraj (Copy)    (Ctrl + C) 

3. postavimo pokazivač miša na mjesto gdje želimo smjestiti kopiju 

http://hr.wikipedia.org/wiki/OpenOffice.org
http://hr.wikipedia.org/wiki/Microsoft_Office
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4. pritisnemo desnu tipku miša i na izborniku odaberemo alat Zalijepi (Paste)     (Ctrl + V) 

 

Kopiranje pomodu uhvati – vuci – pusti (Drag and drop) 

1. označimo datoteku ili mapu koju želimo kopirati 

2. na označenoj datoteci ili mapi pritisnemo i zadržimo lijevu tipku miša te pritisnemo i 

zadržimo tipku Ctrl 

3. vučemo pokazivač miša 

4. otpustimo tipku miša i potom tipku Ctrl. Kopija je zalijepljena na novu poziciju 

 

Premještanje datoteka ili mapa: 

1. označimo datoteku ili mapu koju želimo premjestiti 

2. pritisnemo desnu tipku miša i na izborniku odaberemo alat Izreži (Cut)   (Ctrl +X) 

3. postavimo pokazivač miša na mjesto gdje želimo premjestiti datoteku ili mapu 

4. pritisnemo desnu tipku miša i na izborniku odaberemo alat Zalijepi (Paste)   (Ctrl + V) 

Premještanje pomodu uhvati – vuci – pusti: kao i kopiranje, ali bez tipke Ctrl 

 

Brisanje datoteka i mapa 

 Windows Explorer > u lijevom prozoru označimo mapu u kojoj se nalazi datoteka ili mapa > u 

desnom prozoru označimo datoteku ili mapu koju želimo obrisati > File > Delete 

 pritisnemo desnu tipku miša na mapu ili datoteku i na izborniku odaberemo alat Delete 

 pritisnemo desnu tipku miša i na izborniku odaberemo alat Delete 

 pritisnemo i zadržimo lijevu tipku miša na datoteci ili mapi koju želimo pobrisati, odvudemo 

pokazivač miša do Smeda / Recycle Bin (metoda uhvati-povuci-pusti, Drag and Drop)  

 

Vradanje datoteka i mapa 

 obrisano odlazi u Koš za smede / Recycle Bin 

 opcije: 

o isprazni koš za smede / Empty the Recycle Bin 

o vrati natrag sve / Restore all items 

 vradanje natrag jedne datoteke: pritisnemo desnu tipku miša na nju i na izborniku 

odaberemo naredbu Vrati / Restore  
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Komprimiranje datoteka i mapa (sažimanje) 

 komprimiranjem se smanjuje prostor koji ti podaci zauzimaju na disku 

 pritisnemo desnu tipku miša na datoteku ili mapu i na izborniku odaberemo naredbu Send to 

(pošalji) > Compressed (zipped) Folder (Komprimirana (zipana) mapa) 

 komprimirana mapa ili datoteka stvori se uz originalnu sa ikonom zatvarača  

 dodavanje datoteka i mapa: metodom uhvati-povuci-pusti (drag and drop) na mapu 

 programi za komprimiranje: Win Zip, Win Rar 

 

Dekomprimiranje (raspakiravanje) komprimiranih mapa i datoteka (extract) 

 da bi mogli modificirati komprimirane 

datoteke ili mape potrebno ih je 

dekomprimirati 

 pritisnemo desnu tipku miša na 

komprimiranu mapu ili datoteku > 

odaberemo program za dekompresiju 

> odredimo lokaciju gdje želimo 

spremiti mapu  

 

 

 

 

Pretraživanje (Search) 

 

 
 

 Kada želimo pronadi nešto što smo zaboravili gdje smo spremili 

 Start > Search > Odabir što želimo pretraživati (Slike, glazbu, video, dokumente, sve datoteke 

i mape, printere…) 

 Najčešde odaberemo All Files and Folders i odredimo podešenja 
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Sortiranje datoteka 

 u prikazu Detalji / Details (na slici ispod) 

 
 pokraj kriterija sortiranja se nalazi sivi trokut, koji pokazuje i dali je sortiranje uzlazno ili 

silazno 

 vrste sortiranja: 

o Ime / Name 

o Veličina / Size 

o Vrsta / Type 

o Datum izmjene / Date modified 

 

UPRAVLJANJE ISPISOM 

 

Promjena zadanog pisača 

 ukoliko postoji više pisača, samo je jedan glavni koji automatski preuzima sve naredbe ispisa 

 promjena: Start > Printers and Faxes > označimo printer > pritisnemo desnu tipku miša > Set 

as default 

 
 

Instaliranje novog pisača na računalo 

 Start > Printers and Faxes > Add printer, ili 

 preko instalacijskog CD-a od printera 
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Ispis dokumenata iz aplikacije za obradu teksta 

 na izborniku Datoteka / File odaberemo Ispis / Print; podesimo željene postavke (broj kopija, 

ispis određenih stranica) i pritisnemo gumb OK 

 
 tijekom ispisa na Traci sa zadadama / Taskbar se pojavi ikona printera > dvostruki pritisak 

lijevom tipkom miša na nju i otvaraju nam se svi poslovi printera 

 dvostruki pritisak lijevom tipkom miša na ikonu printera na Traci sa zadadama, odaberemo 

posao koji želimo prekinuti ili pauzirati tako da pritisnemo desnu tipku miša na njega i 

odaberemo Otkaži / Cancel ili Pauziraj / Pause  

 

 

 

KORIŠTENJE PROGRAMA 

 

Rad s programima unutar operativnog sustava Windows XP 

 Start > All Programs > Accessories: 

 

o Bojanje (Paint) 

 program za crtanje i slikanje te 

jednostavniju obradu fotografija 

o Blok za pisanje (Notepad) 

 program za jednostavno pisanje 

s osnovnim oblikovanjima 

o Kalkulator (Calculator) 
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Rad s programom za obradu teksta (OpenOffice Writer, Microsoft Office Word) 

 kod prve pohrane dokumenta: na izborniku Datoteka /File odaberemo Spremi kao / Save as i 

u dijaloškom okviru koji se pojavi odredimo mjesto spremanja Spremi u / Save in te unesemo 

ime datoteke; na kraju pritisnemo gumb Spremi / Save 

 

Formatiranje medija za pohranu podataka (disketa, memorijski štapić 

(memory stick), tvrdi disk (hard disk) isl.) 

 potpuno brisanje i ponovno pripremanje za rad 

 u prozoru My Computer pritisnemo desnu tipku miša na ono što se 

želi formatirati i odaberemo opciju Format, te pritisnemo gumb OK 

 podaci na formatiranom disku su nepovratno izbrisani pa je 

poželjno napraviti kopiju prije formatiranja 

 ukoliko ste greškom formatirali medij te time izbrisali podatke, 

podatke je mogude vratiti pomodu specijaliziranih programa te Vam 

savjetujemo da se obratite računalnom stručnjaku 

 

Antivirusni program (Norton, McAfee, Sophos) 

 program koji se koristi za zaštitu od računalnih virusa 

 na traci sa zadadama se nalazi ikona instaliranog antivirusnog programa; desnom tipkom 

miša na tu ikonu pojavljuje se opcija za ažuriranje programa Start update  

 

Korištenje ispisa ekrana (Print Screen) 

 koristi se kad ekran koji trenutno vidimo želimo spremiti kao sliku 

 pritisnemo tipku PrtSc (puni naziv: Print Screen) na tipkovnici 

 otvorimo aplikaciju gdje želimo spremiti sliku npr.  OpenOffice Writer, Microsoft Word, MS 

Paint 

 alatom Zalijepi / Paste postavljamo sliku na željeno mjesto 

 

 

Upravljačka ploča (Control panel) 

 

 za podešavanja 

rada računala; 

ikona se nalazi na 

startnom izborniku 

 pogledi: 

o po kategorijama 

/ Category view  

o klasičan pogled/ 

Classic view 

 

 

 

 

http://hr.wikipedia.org/wiki/Antivirusni_program


ITdesk.info – projekt računalne e-edukacije sa slobodnim pristupom 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License.  16/20 

Dobivanje osnovnih sistemskih informacija: 

 na klasičnom pogledu otvorimo ikonu  

 

 

Promjena slike na radnoj površini 

 možemo postaviti bilo koju sliku pohranjenu na računalo kao sliku na radnoj površini 

 na Upravljačkoj ploči otvorimo ikonu Prikaz / Display, ili pritisnemo desnu tipku miša bilo gdje 

na radnoj površini (ne na ikonu!) i odaberemo Svojstva / Properties na brzom izborniku 

 
 na kartici Desktop na dijelu Pozadina / 

Background odaberemo sliku. Potvrdimo 

promjenu gumbom Primjeni / Apply i pritisnemo 

gumb OK  

 odabirom gumba Browse odabiremo sliku bilo 

gdje na računalu  

 

 

 

 

 

 

 

 

Podešavanje čuvara zaslona (Screen Saver) 

 dinamičnom slikom štiti monitor; prekida se 

pomakom miša ili dodirom tipkovnice 

 na Upravljačkoj ploči otvorimo ikonu Prikaz / 

Display i na kartici Screen Saver odaberemo jedan od 

ponuđenih čuvara zaslona; u polju Wait određujemo 

vrijeme koje treba prodi bez pomicanja miša da bi se 

čuvar zaslona uključio. Potvrdimo promjenu gumbom 

Primjeni / Apply i pritisnemo gumb OK  
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Promjena rezolucije ekrana 

 piksel (eng. pixel = picture element) je osnovni 

element od koje se sastoji slika na zaslonu 

monitora. Za monitor koji može prikazati više 

točaka kažemo da je njegova slika bolja tj. 

kvalitetnija. Kvalitetu slike monitora opisujemo 

pojmom rezolucija ili razlučivost. 

 rezolucija ekrana ovisi o kvaliteti monitora i 

grafičke kartice 

 na Upravljačkoj ploči otvorimo ikonu Prikaz / 

Display i na kartici Settings u dijelu Screen 

Resolution pomičemo klizač. Potvrdimo promjenu 

gumbom Primjeni / Apply i pritisnemo gumb OK 

 

 

Promjena vremena i datuma 

 Start > Upravljačka ploča > Datum i vrijeme 

(Start > Control panel > Date and Time), ili dvostruki 

pritisak na lijevu tipku miša na sat u desnom kutu trake 

sa zadadama  

 nakon unesenih promjena za datum i vrijeme, 

obavezno potvrdimo unos (gumb Primjeni / Apply) i 

zatim gumb OK 

 

 

 

Deinstaliranje programa 

 na Upravljačkoj ploči otvorimo ikonu Add/Remove; odaberemo program koji želimo ukloniti i 

odaberemo 

gumb Remove 
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Instaliranje novih programa 

 novi programi isporučuju se na CD, DVD ili ih imamo u mapi na računalu 

 pokredemo instalaciju dvostrukim pritiskom na setup.exe ili install.exe 

 pokreče se Čarobnjak za instalaciju, a mi eventualno odabiremo Next, yes ili upisujemo 

serijski broj 

 
 

Postavke i promjene jezika na tipkovnici 

 operativni sustav Windows ima podršku za veliku vedinu službenih jezika 

 na Upravljačkoj ploči otvorimo ikonu Regional and Language Options > Languages > Details  

 ako nije ponuđen dodamo željeni jezik opcija Add  

 

Podešavanje brzine dvostrukog pritiska lijeve tipke miša 

 Start > Control Panel > Mouse > Buttons > Double-click speed > pomičemo klizač > Apply > 

OK 

 

Podešavanje zvuka i zvučnika 

 na Upravljačkoj ploči otvorimo ikonu Sound napravimo željena podešenja i pritisnemo gumb 

OK  
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Ova skripta je namijenjena za učenje uz materijale 

objavljene na slijedećim linkovima: 

 

 

* Priručnik:  

http://www.itdesk.info/prirucnik_koristenje_racunala_upravljanje_datotekama.pdf  

 

* Video prezentacije koje prikazuju osnovno korištenje računala i upravljanje datotekama: 

 http://www.itdesk.info/hrvatski/osnove-racunala-1/ 

 http://www.itdesk.info/hrvatski/osnove-racunala-2/ 

 http://www.itdesk.info/hrvatski/osnove-racunala-3/ 

 

* Probni ispit: 

http://www.itdesk.info/primjeri ispita/primjer ispita modul 2.pdf 

  

* Video-prezentacija koja prikazuje rješavanje primjera ispita: 

http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-video-rjesenje-

ispita/ 

 

* Kvizevi koji korisnici/ce sami rješavaju: 

 http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-1/ 

 http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-2/ 

 http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-3/ 

 

(za otvaranje linka koji se nalazi unutar PDF dokumenta samo pritisnite lijevu tipku miša na jedan od 

navedenih linkova. Web stranica na koju link pokazuje de se otvoriti u Internet pregledniku kojeg 

imate instaliranog na računalu.) 

  

http://www.itdesk.info/prirucnik_koristenje_racunala_upravljanje_datotekama.pdf
http://www.itdesk.info/prirucnik_koristenje_racunala_upravljanje_datotekama.pdf
http://www.itdesk.info/hrvatski/osnove-racunala-1/
http://www.itdesk.info/hrvatski/osnove-racunala-2/
http://www.itdesk.info/hrvatski/osnove-racunala-3/
http://www.itdesk.info/primjeri%20ispita/primjer%20ispita%20modul%202.pdf
http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-video-rjesenje-ispita/
http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-video-rjesenje-ispita/
http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-1/
http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-2/
http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-3/
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Opći uvjeti korištenja: 

 

Web stranicu www.ITdesk.info je pokrenula udruga „Otvoreno društvo za razmjenu 

ideja - ODRAZI“ u sklopu aktivnog promoviranja ljudskog prava na slobodan 

pristup informacijama te ljudskog prava na edukaciju. 

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate ništa u 

njemu! 

 

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info 

isključivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zaštitni 

znakovi tvrtke Microsoft Corporation. Ostali zaštitni znaci korišteni na ITdesk Home Web stranicama 

su isključivo vlasništvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu ili 

redistribuciju bilo kojeg programa, molimo kontaktirajte autore/ice dotičnog programa. Sva dodatna 

pitanja pošaljite na info@itdesk.info.  

___________________________________ 

Ove web stranice sadržavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE 

odgovoran za tekstualni i/ili reklamni sadržaj, odnosno za proizvode koji su na tim web 

stranicama/izvorima ponuđeni, kao sto NIJE odgovoran niti za sadržaj koji je putem njih dostupan; 

mogućnost korištenja ili točnost sadržaja. Linkove koristite na vlastitu odgovornost. Također, 

ITdesk.info team ne garantira: 

 da je sadržaj na ovim web stranicama oslobođen od pogrešaka ili pogodan za svaku svrhu, 

 da će ove web stranice ili web usluge funkcionirati bez pogrešaka ili prekida, 

 da će biti odgovarajući za vaše potrebe, 

 da implementacija takvog sadržaja neće narušavati patente, autorska prava, zaštitni znak ili 

ostala prava neke treće strane. 

Ukoliko se ne slažete s ovim općim uvjetima korištenja ili ako niste zadovoljni web stranicama koje 

pružamo, prekinite s korištenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran 

vama, niti trećim osobama za bilo koju nastalu štetu, bila ona direktna, indirektna, slučajna ili 

posljedična, povezana s ili proizlazeća iz vaše uporabe, pogrešne uporabe ovih web stranica ili web 

usluga. Iako vaše potraživanje može biti bazirano na garanciji, ugovoru, prekršaju ili nekom drugom 

pravnom uporištu, neovisno o našoj obaviještenosti o mogućnosti nastanka takve štete, oslobađamo se 

svake odgovornosti. Prihvaćanje ograničenja naše odgovornosti nužan je preduvjet korištenja ovih 

web stranica i web usluga 

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni 

samo za edukativne svrhe ili kao primjer te mi, na bilo koji način, ne preferiramo navedeni softver u 

odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo više u odnosu na 

drugi, koji se spominje ili ne spominje u materijalima, smatrat će se kao lažni iskaz. Našu izravnu i 

bezrezervnu podršku imaju jedino softveri otvorenog koda (open source) koji omogućuju 

korisnicima/cama da bez prepreka postanu digitalno pismeni, koriste računalo i sudjeluju u modernom 

informatičkom društvu. 

mailto:info@itdesk.info
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